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Changes
The material in this document is for information only and is subject to change 
without notice. While reasonable efforts have been made in the preparation of this 
document to assure its accuracy, Roxio, Inc. assumes no liability resulting from errors 
or omissions in this document, or from the use of the information contained herein.

Roxio reserves the right to make changes in the product design without reservation 
and without notification to its users.

Disclaimer
IF THIS PRODUCT DIRECTS YOU TO COPY MATERIALS, YOU MUST HAVE 
PERMISSION FROM THE COPYRIGHT OWNER OF THE MATERIALS TO AVOID 
VIOLATING THE LAW WHICH COULD RESULT IN DAMAGES OR OTHER 
REMEDIES.

About OEM Software 

What is OEM?

A Roxio OEM (Original Equipment Manufacturer) product is one that was sold by 
Roxio to another company for integration or use with their product. If your software 
product came bundled with another manufacturer’s product it is an OEM product. 
The software is sometimes modified for the CD-recorder it is bundled with. 

How do I obtain technical support for my OEM product?

Roxio does not directly support these products. The Roxio product is part of the 
OEM’s product offering and therefore supported by them. If you have one of these 
Roxio OEM products, please contact the OEM for your support options. 

You may also wish to visit our website at http://www.roxio.com. At the Roxio site you 
will find extensive self help material as well as ways to contact us for paid support.
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Roxio, Inc., OEM Version End User License Agreement

PLEASE READ CAREFULLY: THE USE OF THIS SOFTWARE IS SUBJECT TO THE 
SOFTWARE LICENSE TERMS OF ROXIO, INC. AND OTHER LICENSORS WHOSE 
SOFTWARE MAY BE BUNDLED WITH THIS PRODUCT.BY YOUR USE OF THE 
SOFTWARE INCLUDED WITH THIS PRODUCT YOU AGREE TO THE LICENSE 
TERMS REQUIRED BY THE LICENSOR OF THAT SOFTWARE, AS SET FORTH 
BELOW. IF YOU DO NOT AGREE TO THE LICENSE TERMS APPLICABLE TO THE 
SOFTWARE, YOU MAY RETURN THE ENTIRE UNUSED PRODUCT TO THE 
SOURCE FROM WHICH YOU OBTAINED IT.

Roxio Software License Agreement
(Single User, Non-Networked Applications)

In return for acquiring a license to use the Roxio software, which may include 
software from third party licensors and patches made available by Roxio ("Software"), 
and the related documentation, you agree to the following terms and conditions:

1. License. This Agreement grants you ("Licensee") a license to:  

 a. use the Software on a single computer system, which is not intended for 
use by more than five (5) users; and 

 b. make one copy of the Software in machine readable form solely for back-up 
purposes, provided you reproduce Roxio's copyright proprietary legends.  
Notwithstanding the foregoing, the Software may be used on the home, 
laptop or other secondary computer of the principal user of the Software, 
and an additional copy of the Software may be made to support such use. 
As used in this license, the Software is "in use" when it is either loaded into 
RAM or installed on a hard disk or other permanent memory device.  The 
Software may be "in use" on only one computer at any given time.  
(Different license terms and fees are applicable for networked or multiple 
user applications.)  As a specific condition of this license, you agree to use 
the Software in compliance with all applicable laws, including copyright 
laws, and that you will not copy, transmit, perform or distribute any audio 
or other content using the Software without obtaining all necessary licenses 
or permissions from the owner of the content.

2. Restrictions.  You may not distribute copies of the Software to others or electronically 
transfer the Software from one computer to another over a network. You are not 
authorized to use any licensed codecs in the Software or the Software itself in real 
time broadcasting (terrestrial, satellite, cable or other media) or broadcasting via the 
Internet or other networks such as, but not limited to, intranets, etc. or in pay-audio 
or audio-on-demand applications. An independent license for any such use is 
required. For details on MP3 licensing, please visit http://www.mp3licensing.com.  
You may not post or otherwise make available the Software, or any portion thereof, 
in any form, on the Internet.  You may not use the Software in a computer service 
business, including in time sharing applications.  The Software contains trade secrets 
and, in order to protect them, you may not decompile, reverse engineer, disassemble, 
or otherwise reduce the Software to a human-perceivable form. Content providers 
are using the digital rights management technology (“DRM”) contained in this 
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intellectual property, including copyright, in such content is not misappropriated.  



Owners of such Secure Content (“Secure Content Owners”) may, from time to time, 
request Roxio or its suppliers to provide security related updates to the DRM 
components of the Software (“Security Updates”) that may affect your ability to 
copy, display and/or play Secure Content through the Software or other applications 
that utilize the Software.  You therefore agree that, if you elect to download a 
license from the Internet which enables your use of Secure Content, Roxio or its 
suppliers may, in conjunction with such license, also download onto your 
computer such Security Updates that a Secure Content Owner has requested that 
Roxio or its suppliers distribute.  Roxio and its suppliers will not retrieve any 
personally identifiable information, or any other information, from your computer 
by downloading such Security Updates. YOU MAY NOT MODIFY, ADAPT, 
TRANSLATE, RENT, LEASE, LOAN, RESELL FOR PROFIT, DISTRIBUTE, 
NETWORK OR CREATE DERIVATIVE WORKS BASED UPON THE SOFTWARE 
OR ANY PART THEREOF. 

3. Ownership of Software.  As Licensee, you own the media upon which the 
software is recorded or fixed, but Roxio and its licensors retain title and ownership 
of the Software recorded on the original media and all subsequent copies of the 
Software, regardless of the form or media in which or on which the original and 
other copies may exist.  This license is not a sale of the Software or any copy.

4. Confidentiality.  You agree to maintain the Software in confidence and that you 
will not disclose the Software to any third party without the express written 
consent of Roxio.  You further agree to take all reasonable precautions to preclude 
access of unauthorized persons to the Software.

5. Term.  This license is effective until January 1, 2045, unless terminated earlier.  You 
may terminate the license at any time by destroying the Software (including the 
related documentation) together with all copies or modifications in any form.  
Roxio will have the right to terminate our license immediately if you fail to 
comply with any term or condition of this Agreement.  Upon any termination, 
including termination by you, you must destroy the Software (including the 
related documentation), together with all copies or modifications in any form.

6. Special Terms Applicable to Databases.  Where a database is included with the 
Software, you acknowledge that it is licensed only in connection with the use of 
the Software to perform disc creation, and that the database and all data derived 
therefrom must be maintained in confidence in accordance with the provisions of 
Section 4.  This license does not grant you any rights to distribute or disclose such 
database or data.

7. Limited Warranty.  Roxio and its Licensors warrants only that the Software will 
perform substantially in accordance with the accompanying written 
documentation for a period of thirty (30) days from the date of your purchase 
receipt.  ROXIO AND ITS LICENSORS DO NOT AND CANNOT WARRANT 
THE RESULTS YOU MAY OBTAIN BY USING THE SOFTWARE OR 
DOCUMENTATION.  THE FOREGOING STATES THE SOLE AND EXCLUSIVE 
REMEDIES ROXIO AND ITS LICENSORS WILL PROVIDE FOR BREACbH OF 
WARRANTY. EXCEPT FOR THE FOREGOING LIMITED WARRANTY, ROXIO 
AND ITS LICENSORS MAKE NO WARRANTIES, EXPRESSED OR IMPLIED, 
INCLUDING, BUT NOT LIMITED, AS TO NON-INFRINGEMENT OF THIRD 
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PURPOSE.  Some states do not allow the exclusion of implied warranties or 
limitations on how long an implied warranty may last, so the above limitations 
may not apply to you.  This warranty gives you specific legal rights and you may 
also have other rights which vary from state to state.

The entire liability of Roxio and its Licensors, and your exclusive remedy for a 
breach of this warranty, shall be: (a) the replacement of any Software not meeting 
the above limited warranty which is returned by you; or (b) if Roxio or its 
distributor is unable to deliver replacement Software you may terminate this 
Agreement by returning the Software and your money will be refunded. If you 
have purchased this Software bundled with a computer hardware product, you 
must return the Software to the computer hardware manufacturer. 

8. Limitation of Liability.  IN NO EVENT WILL ROXIO OR ITS LICENSORS BE 
LIABLE TO YOU FOR ANY INCIDENTAL, CONSEQUENTIAL OR INDIRECT 
DAMAGES, INCLUDING ANY LOST PROFITS, LOST SAVINGS, OR LOSS OF 
DATA, EVEN IF ROXIO OR A LICENSOR HAS BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES, OR FOR ANY CLAIM BY ANY OTHER 
PARTY.  Some states do not allow the exclusion or limitation of special, incidental, 
or consequential damages, so the above limitation or exclusion may not apply to 
you.

9. Export.  You acknowledge that the laws and regulations of the United States and 
other countries may restrict the export and re-export of the Software.  You agree 
that you will not export or re-export the Software or documentation in any form in 
violation of applicable United States and foreign law.

10. Indemnity. You agree that Roxio shall have no liability whatsoever for any use you 
make of the Software. You shall indemnify and hold harmless Roxio from any 
third party claims, damages, liabilities, costs and fees (including reasonable 
attorney fees) arising from your use of the Software as well as from your failure to 
comply with any term of this Agreement.

11. Government Restricted Rights.  The Software is subject to restricted rights as 
follows.  If the Software is acquired under the terms of a GSA contract: use, 
reproduction or disclosure is subject to the restrictions set forth in the applicable 
ADP Schedule contract.  If the Software is acquired under the terms of a DoD or 
civilian agency contract, use, duplication or disclosure by the Government is 
subject to the restrictions of this Agreement in accordance with 48 C.F.R. 12.212 of 
the Federal Acquisition Regulations and its successors and 49 C.F.R. 227.7202-1 of 
the DoD FAR Supplement and its successors

12. General.  You acknowledge that you have read this Agreement, understand it, and 
that by using the Software you agree to be bound by its terms and conditions.  You 
further agree that it is the complete and exclusive statement of the agreement 
between Roxio and you, and supersedes any proposal or prior agreement, oral or 
written, and any other communication between Roxio and you relating to the 
subject matter of this Agreement.  No additional or any different terms will be 
enforceable against Roxio unless Roxio gives its express consent, including an 
express waiver of the terms of this Agreement, in writing signed by an officer of 
Roxio.  You assume full responsibility for the use of the Software and agree to use 
vi

the Software legally and responsibly.  This Agreement shall be governed by 



California law, except as to copyright matters, which are covered by Federal law. 
This Agreement is deemed entered into at Milpitas, California by both parties.  
Should any provision of this Agreement be declared unenforceable in any 
jurisdiction, then such provision shall be deemed severable from this Agreement   
and shall not affect the remainder hereof.  All rights in the Software not 
specifically granted in this Agreement are reserved by Roxio.

Should you have any questions concerning this Agreement, you may contact Roxio 
by writing to:  

Roxio, Inc.
Legal Department
461 South Milpitas Boulevard
Milpitas, California  95035.
vii
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Introduction
In This Chapter

Use Easy CD Creator 5 Basic to make your own CDs. In just a couple 
of mouse clicks, you can make music CDs that can be played on 
your home or car stereo CD player, or make data CDs for storing 
computer data such as the files and folders on your hard disk. 

Here are some of things you can do with Easy CD Creator 5 Basic:

■ Make high-quality music CDs from any source including other 
music CDs and audio files (WAV, MP3, or WMA).

■ Archive and store your computer data on a data CD.

■ Make backup copies of your favorite music or data CD.

 ➤ Included with Easy CD Creator 2

 ➤ System Requirements 2

 ➤ Uninstalling Easy CD Creator 3

 ➤ Installing Easy CD Creator 3

 ➤ Starting Easy CD Creator 4

 ➤ What Types of Blank CDs Should I Use? 5

 ➤ How Much Data or Music Can I Fit on a CD? 6
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Introduction

Included with Easy CD Creator
Easy CD Creator includes all of the following applications:

■ Easy CD Creator: Make music CDs from other CDs, MP3, and 
more. Make data CDs for sharing and archiving data in the 
most compatible format.

■ DirectCD: Make data CDs that allow you to write directly to a 
CD-Recordable or CD-ReWritable disc just like you would 
write files to a floppy disk or removable drive.

■ CD Copier: Make backup copies of your music and data CDs.

System Requirements
Here are the minimum system requirements for Easy CD Creator:

■ IBM PC or compatible 200 MHz or faster

■ Windows 95/98/NT4/2000/Me/XP

■ 32 MB RAM (64 MB RAM recommended)

■ 50 MB free hard disk space

■ CD-Recordable or CD-ReWritable drive

■ CD-ROM drive that supports digital audio extraction (for 
making a music CD from other music CDs) 

■ Blank CD-R or CD-RW discs

■ 800 x 600 display, 256 colors minimum, 16-bit color 
recommended

■ Windows-compatible sound card (16-bit or better)

■ Internet access to take advantage of Internet features

Note: Your system may require minor adjustments to the 
configuration of your operating system, additional hard 
disk space, and updates to hardware component drivers. 
Results may vary based on your equipment.
2
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Uninstalling Easy CD Creator
Roxio recommends that you uninstall any older versions or 
evaluation versions of Easy CD Creator prior to installing new 
versions.

To uninstall Easy CD Creator, use the use the Add/Remove 
Programs Properties dialog box in the Windows Control Panel.

To access the Add/Remove Programs Properties dialog box:

■ On the Windows taskbar, click Start, point to Settings, click 
Control Panel, and then double-click Add/Remove Programs. 

Installing Easy CD Creator
To install Easy CD Creator:

1 Insert the Roxio Easy CD Creator 5 Basic CD into your 
CD-Recorder or CD-ROM drive.

Note: In this guide, the term CD-Recorder refers to both 
CD-Recordable and CD-ReWritable drives.

If Autorun is enabled on your system, the Roxio Installation 
window appears automatically and you can skip Steps 2 and 3.

2 From the Start menu, select Run.

3 Type d:\setup (substitute the appropriate letter of your 
CD-Recorder or CD-ROM drive for d.)

4 Follow the installation instructions that appear on the screen.
3
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Starting Easy CD Creator
The easiest way to start Easy CD Creator is from Easy CD Creator 
Project Selector. Project Selector makes it easy to select the right 
application for the type of CD you want to make. You can access 
Project Selector by doing any of the following:

■ Insert a blank CD into your CD-Recorder.

■ On the Windows taskbar, click Start, point to Programs, point 
to Roxio Easy CD Creator 5, and select Project Selector.

■ Double-click the Project Selector icon on the Windows desktop.

■ Double-click the Project Selector icon  on the Windows 
taskbar.

Using Project Selector
To use Project Selector:

1 Roll your pointer over the Project Selector buttons on the left of 
the window. The applications are grouped by project type.

As your pointer rolls over each button, a submenu appears on 
4
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2 To open the application you want to use, click its button in the 
submenu.

Note: If an option is grayed-out, it is unavailable in the 
version of Easy CD Creator 5 you currently have installed. 
Please upgrade to Easy CD Creator 5 Platinum to install the 
option.

What Types of Blank CDs Should I Use?
There are two types of blank CDs (recordable media) that are used 
for making your own CDs:

■ CD-R discs (CD-Recordable)

■ CD-RW discs (CD-ReWritable)

You can obtain blank CD-R or CD-RW discs where you purchased 
your CD-Recorder or at local computer retailers.

When to Use CD-R Discs
Virtually all CD-ROM and CD-Recorder drives can read CD-R discs. 
CD-R discs are excellent for permanent data storage and should be 
used when you do not need to erase the data. They are less 
expensive per CD than CD-RW discs. Here are some ideas for using 
CD-R discs:

■ When you want to make a music CD that you can play on your 
home or car stereo CD player.

■ When you want to copy a music CD for your own personal 
use.

■ When you want to permanently save large project files.

■ When you want to permanently archive or store files, such as 
your home records, photos, or videos.
5
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When to Use CD-RW Discs
CD-RW discs can only be used in CD-ReWritable drives and 
MultiRead CD-ROM drives. You cannot play a music CD made on a 
CD-RW disc in most home or car stereo CD players. Here are some 
ideas for using CD-RW discs:

■ When you need to write, erase, rewrite, and update all your 
large files on CD.

■ When you want to make a practice CD or test the contents of a 
CD before making a permanent one.

How Much Data or Music Can I Fit on a CD?
The actual capacity of blank CDs can vary slightly; some 74-minute 
CDs can hold up to two minutes more than their stated capacity. 
Easy CD Creator lets you record as much data or music as the CD 
can hold. Here are the typical capacities of the CD-Recordable media 
available:

■ Blank CD-R discs: Available in two capacities: 650 MB 
(74-minute) and 700 MB (80-minute). 

■ Blank CD-RW discs: Available in a 650 MB (74-minute) 
capacity only. 

■ Blank mini CD-R discs: Available in a 180 MB (21-minute) 
capacity only.
6
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Making Music CDs Using 
Easy CD Creator
In This Chapter

A music CD is a compact disc (CD) used for playing back music on 
your home or car stereo CD player. With Easy CD Creator, you can 
make your own music CD by recording tracks from other music 
CDs, and from audio files (for example, WAV, MP3, or WMA files) 
stored on your hard disk.

 ➤ Making a Music CD 8

 ➤ Making Music CDs with a CD-Recorder Only 10

 ➤ Making a Compilation Music CD 11

 ➤ Tips for Making a Music CD 12

 ➤ Working with Tracks in the Music CD Project 13

 ➤ Playing a Track 16

 ➤ Viewing the Status Bar 17

 ➤ Viewing the CD Info Bar 18

 ➤ Saving and Opening a CD Project 19

 ➤ Accessing the Online Music Database on the Internet 19

 ➤ Advanced Music CD Topics 20
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Here are just some of the things you should know about a music CD:

■ Unlike a data CD, a music CD is used for playing back music 
and not for data storage.

■ In addition to your home or car stereo CD player, a music CD 
can also be played on just about every computer that has a 
CD-ROM or CD-Recorder, using a program such as the 
Windows CD Player.

■ With Easy CD Creator, you can make a music CD that can 
typically hold up to 74 or 80 minutes of music and up to 99 
tracks.

■ With Easy CD Creator, you can make your own compilation 
music CD that contains tracks from other music CDs and audio 
files.

Making a Music CD
To make a music CD:

1 Start a new music CD project. From the Easy CD Creator 
Project Selector window, click Make a Music CD, then click 
Music CD Project. An untitled music CD project appears.

2 Insert a blank CD into your CD-Recorder (the destination 
drive).

Source Window

Music CD Project
8
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3 Add the music tracks you want to record to the music CD 
project (if you are recording audio files only, skip to Step 4):

Note: You can add any combination of music tracks, WAV, 
MP3, or WMA files to a music CD project. Up to 99 tracks 
and files, or up to 650 MB (74-minute CD) or 700 MB 
(80-minute CD) of tracks and files can be added to a music 
CD project.

a Insert the music CD into your CD-ROM drive (the source 
drive) and allow the CD to spin up.

b In the Select Source Files drop-down list box, select the 
CD-ROM drive containing the music CD; a list of the tracks 
on the CD appears in the Source window.

Note: If information about the music CD is found locally on 
your hard disk, the CD title, artist name, and the name of 
each track are displayed in the Source window. If this 
information does not appear, and you have access to the 
Internet, click Name to download the information from the 
online music database. 

c Select the track (hold down the Ctrl or Shift key to select 
multiple tracks) in the Source window, and then click Add. 
The track is added to the music CD project.

Note: Tracks from multiple CDs can be added to the music 
CD project by repeating Steps a–c (this is especially useful 
when you want to make a compilation music CD). During 
the actual record process you are prompted to insert the 
appropriate music CD for the track being recorded.
9
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4 Add the audio files you want to record to the music CD 
project:

a In the Select Source Files drop-down list box, select the 
folder where your files are located; a list of all audio files in 
the folder appears in the Source window.

b Select the file (hold down the Ctrl or Shift key to select 
multiple files) in the Source window, and then click Add. 
The file is added to the music CD project.

5 Click Record. The Record CD Setup dialog box appears.

6 Click Start Recording.

Making Music CDs with a CD-Recorder Only
Making a music CD from other music CDs is typically done using 
both a CD-ROM drive (capable of digital audio extraction) and a 
CD-Recorder. If you have a CD-Recorder only, and you want to 
record tracks from other music CDs, you can do one of the 
following:

■ Save tracks on music CDs to hard disk first: This method 
requires you to convert each track on the music CD you want 
to record to an audio file (WAV, MP3, or WMA) on your hard 
disk. Once saved to your hard disk, you can add the audio file 
to your music CD project and record it just like you would a 
normal music CD. See Converting a Track to a WAV or WMA File 
on page 14.

Note: Users that have both a CD-ROM and CD-Recorder also 
commonly use this method.

■ Swap CDs in and out of your CD-Recorder: This method 
requires you to add tracks to your music CD project and record 
the tracks just like you would a normal music CD. You will be 
required to insert and reinsert the music CDs that contain the 
tracks you want to record. See Making a Music CD on page 8. 
10
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Making a Compilation Music CD
A compilation music CD is a music CD made from a variety of 
music sources including other music CDs and audio files (WAV, 
MP3, or WMA). Making a compilation music CD is the same as 
making a music CD in Easy CD Creator. Here are some helpful tips 
on making a compilation music CD:

■ Retrieve CD title, artist and track names, and track lengths 
from the Internet: If you are recording tracks from music CDs, 
you can automatically retrieve information about a 
commercially produced music CD, including the CD title, artist, 
and track names from the online music database on the Internet. 
See Accessing the Online Music Database on the Internet on page 19. 
This information helps Easy CD Creator identify CDs.

Note: If you do not have Internet access, manually name 
each music CD you are recording from with a CD title, artist 
name, and track names. See Editing the CD Title and Artist 
Name and Editing Track Titles on page 15.

■ Label your music CD project with CD title and artist name: 
Before recording your CD, you may want to label the CD by 
providing a new CD title and artist name in your music CD 
project. See Editing the CD Title and Artist Name on page 15.

■ Inserting and reinserting music CDs: If you are recording 
tracks from music CDs, during the actual record process, you 
will be prompted to insert the appropriate music CD for the 
track being recorded. If you have several tracks from different 
CDs, be prepared to remove and insert CDs into your source 
drive when prompted. An alternative method for recording 
tracks from music CDs is to save the tracks to hard disk first, as 
described below.

■ Save tracks on music CDs to hard disk first: This method 
requires you to convert each track on the music CD you want 
to record to an audio file (WAV or WMA) on your hard disk. 
Once saved to your hard disk, you can add the audio file to 
your music CD project and record it just like you would a 
normal music CD. See Converting a Track to a WAV or WMA File 
11
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Making Music CDs Using Easy CD Creator

Tips for Making a Music CD
Here are a few tips for making music CDs:

■ Copy an entire music CD with CD Copier: To make a backup 
copy of an entire music CD from start to finish, use CD Copier. 
See Chapter 5, Copying CDs Using CD Copier.

■ Convert a track to WAV or WMA format: To save a track on an 
existing music CD to your hard disk drive, convert the track to 
a WAV or WMA audio format. Once saved to your hard disk, 
you can add the audio file to your music CD project and record 
it just like you would a normal music CD. See Converting a 
Track to a WAV or WMA File on page 14.

■ Retrieve the CD title, artist name, and track titles from the 
Internet: To retrieve the CD title, artist name, and track titles 
for a commercially produced music CD, use the online music 
database available with Easy CD Creator. See Accessing the 
Online Music Database on the Internet on page 19.

■ Label your music CD project with CD title and artist name: 
Before recording your CD, you may want to label the CD by 
typing a new CD title and artist name for your music CD 
project. Once the CD is recorded, you cannot change the title 
and name.

■ Record in Disc-at-Once (DAO) mode to eliminate the two-
second gap between tracks: To prevent a two-second gap from 
occurring between the music tracks, record your music CD 
using the Disc-at-Once option. When making the CD, select 
Disc-at-Once from the Record CD Setup dialog box.

■ Preview a track: To hear a track as it will be recorded to your 
CD, preview the track before recording it to CD. This is 
especially useful if you want to preview any effects applied to 
a track. See Previewing a Track on page 13.

■ Save your music CD project: You can save your music CD 
project to record a CD at a later time. When saving a music CD 
project, you are saving a file that contains only the instructions 
that specify which tracks and files to include in the music CD 
project. See Saving and Opening a CD Project on page 19.
12
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Working with Tracks in the Music CD Project
Once you have added one or more tracks to your music CD project, 
you have the following options:

■ Previewing a Track 

■ Converting a Track to a WAV or WMA File 

■ Merging (Composite) Tracks 

■ Splitting Composite Tracks 

■ Editing the CD Title and Artist Name 

■ Editing Track Titles 

■ Changing the Order of Your Tracks 

■ Removing a Track from the Music CD Project 

Previewing a Track
Previewing a track allows you to hear a track as it will be recorded 
to your CD. This is especially useful if you want to preview any 
effects applied to a track.

Note: A sound card and speakers are required if you want to 
preview the tracks.

To preview tracks:

1 In the music CD project, select one or more tracks.

2 Click Preview. The Easy CD Creator Media Player appears and 
begins playing the selected tracks.
13
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Converting a Track to a WAV or WMA File
Easy CD Creator allows you to save tracks on an existing music CD 
to your hard disk drive. You can name the tracks you save, select the 
format (WAV or WMA), and select the format quality (for example, 
CD Quality).

To convert a track from an existing music CD:

1 Start a new music CD project. From the File menu, point to 
New CD Project, then select Music CD Project.

2 Insert the music CD that contains the music track you want to 
convert into your CD-ROM drive (the source drive) and allow 
the CD to spin-up.

3 In the Select Source Files drop-down list box, select the 
CD-ROM drive containing the music CD; a list of the tracks on 
the CD appears in the Source window.

Note: If information about the music CD is found locally on 
your hard disk, the CD title, artist name, and the name of 
each track are displayed in the Source window. If this 
information does not appear, and you have access to the 
Internet, click Name to download the information from the 
online music database.

4 In the Source window, select the track you want to convert.

5 Click Convert. The Convert Audio Track(s) dialog box 
appears.

6 In the Save In drop-down list box, select a location for the file.

7 In the File Name text box, type a name for the file.

8 In the Save as Type drop-down list box, select the format type:

■ WAV 

■ WMA 

9 In the Format drop-down list box, select the format quality you 
want for the file and click Save. The available options vary 
depending on your system. In general, higher quality settings 
14
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Note: Click Options / Hide Options on the Convert Audio 
Track(s) dialog box, to show or hide the options.

Merging (Composite) Tracks
A composite track is a single track that is made up of two or more 
separate tracks.

To make a composite track:

1 Select two or more tracks you want to merge.

2 From the Track menu, select Merge Tracks.

The tracks appear as a single track in the music CD project. 

Splitting Composite Tracks
A composite track is a single track that is made up of two or more 
separate tracks.

To separate a composite track:

1 Select the composite track you want to separate.

2 From the Track menu, select Split Tracks. The composite track 
appears as multiple tracks in the music CD project. 

Editing the CD Title and Artist Name
To uniquely identify the music CD you are making, you can type a 
CD title and artist name for the CD:

■ Click the New CD Title text box or Artist Name text box and 
type a new name.

Editing Track Titles
You can rename each track in the music CD project:

1 Right-click the track name you want to edit in the music CD 
project.

2 Select Rename.
15
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Changing the Order of Your Tracks
The order of the tracks as they appear in the music CD project is the 
order they are recorded to CD.

To change the order of the tracks:

■ Select the track you want to change the order of and drag it to 
the new position.

Removing a Track from the Music CD Project
Removing a track from the music CD project does not remove the 
original track on the music CD, or the WAV, MP3, or WMA file on 
your hard disk.

To remove a track from the music CD project:

1 Select the track in the music CD project.

2 Click Remove. 

Playing a Track
The media player included with Easy CD Creator allows you to play 
one or more music tracks or audio files.

Note: A sound card and speakers are required if you want to 
play the tracks or audio files. To play a music track on CD, 
the sound card must be connected to the source 
CD-Recorder or CD-ROM drive with an audio cable.

To play a music track on a CD:

1 Insert the music CD into your CD-ROM drive (the source 
drive) and allow the CD to spin up.

2 In the Select Source Files drop-down list box, select the 
CD-ROM drive containing the music CD; a list of the tracks on 
the CD appears in the Source window.
16
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Note: If information about the music CD is found locally on 
your hard disk, the CD title, artist name, and the name of 
each track are displayed in the Source window. If this 
information does not appear, and you have access to the 
Internet, click Name to download the information from the 
online music database.

3 Select one or more tracks in the Source window, and then click 
Preview. The Easy CD Creator Media Player appears and 
begins playing your tracks.

To play an audio file (WAV, MP3, or WMA) on your hard disk:

1 In the Select Source Files drop-down list box, select the folder 
where the audio file is located; the audio files in the folder 
appear in the Source window.

2 Select one or more audio files in the Source window, and then 
click Preview. The Media Player appears and begins playing 
your tracks.

Viewing the Status Bar
The Status bar at the bottom of the music CD project displays 
messages about the function of the selected command or button.

Status Bar
17
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The Status bar also displays the following information about the 
music CD project:

■ Number of tracks in the music CD project

■ Type of CD (Double-click this field to display the CD Project 
Properties dialog box.)

■ File System Option—Joliet or ISO 9660 (Double-click this field 
to display the CD Project Properties dialog box.)

■ CD-Recorder (Double-click this field to display the CD Drive 
Properties dialog box.)

■ Write Method—Disc-at-Once or Track-at-Once (Double-click 
this field to change between DAO and TAO.)

To hide or show the Status bar:

■ From the View menu, select Status Bar. 

Viewing the CD Info Bar
The CD Info bar at the bottom of the music CD project displays the 
amount of free space available (in minutes and seconds) on the CD.

To show or hide the CD Info bar:

■ From the View menu, select CD Info Bar.

CD Info Bar
18



Making Music CDs Using Easy CD Creator

Saving and Opening a CD Project
You can create a CD project (music, data, or bootable CD), save it, 
then use it to record a CD at a later time.

Note: When saving a CD project, you are saving a file that 
contains only the instructions that specify which files to 
include in the CD project.

To save a CD project:

1 From the File menu, select Save Project List As.

2 Type a file name, and select a location for the file.

3 Click Save.

To open a CD project:

1 From the File menu, select Open CD Project.

2 Select the CD project (.cl5) you want to open.

3 Click Open. 

Accessing the Online Music Database on the 
Internet
The online music database is available if you have Internet access. 
Accessing the database allows you to automatically retrieve 
information about a commercially produced music CD, including 
the CD title, artist, and track names.

To access the online music database:

1 Insert the music CD into your CD-ROM drive (the source 
drive) and allow the CD to spin-up.

2 In the Select Source Files drop-down list box, select the 
CD-ROM containing the music CD; a list of the tracks on the 
CD appears in the Source window.
19
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Note: If information about the music CD is found locally on 
your hard disk, the CD title, artist name, track names, and 
track lengths are displayed in the Source window. If this 
information does not appear, and you have access to the 
Internet, continue with Step 3.

3 Click Name.

If you are not currently logged on to the Internet, you are 
asked to do so. If you are already logged on to the Internet, the 
online music database is accessed. If the CD is found in the 
database, the CD title, artist, and track names are displayed in 
the Source window.

Advanced Music CD Topics

Writing a UPC
Easy CD Creator allows you to write a Universal Product Code 
(UPC) for identifying each track (necessary for commercial CDs). A 
UPC can be entered from the CD Project Properties dialog box.

To view the CD Project Properties dialog box:

■ From the File menu, select CD Project Properties.

The CD Project Properties dialog box appears. Click Help on the 
dialog box for information about the properties.
20
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Entering ISRC Information
Easy CD Creator allows you to enter International Standard 
Recording Code (ISRC) information for the music CDs that you 
make. This information includes each track’s author, country of 
origin, and year of production. ISRC information can be entered 
from the Audio Track Properties dialog box.

To view the Audio Track Properties dialog box:

1 Right-click the track you want to provide ISRC information for 
in the music CD project.

2 Select Properties.

The Audio Track Properties dialog box appears. Click Help on the 
dialog box for information about the properties.
21
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Making Data CDs Using 
Easy CD Creator
In This Chapter

A data CD is a compact disc (CD) used for storing computer data. 
With Easy CD Creator, you can make your own data CD by 
recording any files and folders stored on your hard disk.

Here are just some of the things you should know about a data CD:

■ Unlike a music CD, a data CD is used for data storage only and 
cannot be played on your home or car stereo CD player.

■ A data CD can typically hold up to 650 MB of data if you have 
a blank 74-minute CD-R or CD-RW disc, and 700 MB of data if 
you have a blank 80-minute CD-R disc.
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 ➤ Working with Files and Folders in the Data CD Project 24
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■ A data CD can be accessed on virtually any computer that has 
a CD-ROM or CD-Recorder drive.

■ A data CD is ideal for backing up and archiving your 
important files such as spreadsheets, tax records, and financial 
data.

■ A data CD is ideal for sharing multimedia presentations, 
graphics, CAD files, Internet downloads, Websites, and 
company documents with your colleagues.

Making a Data CD
To make a data CD:

1 Start a new data CD project. From the Easy CD Creator Project 
Selector window, click Make a Data CD, then click Data CD 
Project. An untitled data CD project appears.

2 Insert a blank CD into your CD-Recorder (the destination drive).

3 In the Select Source Files drop-down list box, select the folder 
where your files are located; a list of all files in the folder 
appears in the Source window.

4 Select the file (hold down the Ctrl or Shift key to select 
multiple files) in the Source window, and then click Add. The 
file is added to the data CD project.

Note: Up to 650 MB (74-minute CD) or 700 MB (80-minute 
CD) of files and folders can be added to a data CD project.

Source Window

Data CD Project
23
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5 Click Record. The Record CD Setup dialog box appears.

6 Click Start Recording.

Working with Files and Folders in the Data CD 
Project
Once you have added one or more files to your data CD project, you 
have the following options:

■ Creating a New Folder

■ Removing Files and Folders 

■ Renaming Files and Folders 

■ Finding Files 

Creating a New Folder
You can create a new folder in your data CD project and then add 
files and folders to that new folder.

To create a new folder:

■ From the Edit menu, select New Folder.

Removing Files and Folders
Removing a file or folder from the data CD project does not remove 
the original file or folder from your hard disk.

To remove a file or folder from the data CD project:

1 Select the file or folder in the data CD project.

2 Click Remove.

3 Click Yes.
24
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Renaming Files and Folders
You can rename files and folders in the data CD project. Renaming a 
file or folder in the data CD project does not change the original 
name of the file or folder on your hard disk.

To rename a file or folder:

1 Right-click the file or folder you want to edit in the data CD 
project.

2 Select Rename.

3 Type a new name. 

Finding Files
To find a file in your system:

1 In the Source window, click the Find Files button.

2 In the Named text box, type the name of the file you are 
looking for.

3 In the Look In drop-down list box, select the drive or folder 
where you want to search.

4 Click Find Now. 

Viewing the Status Bar
The Status bar at the bottom of the data CD project displays 
messages about the function of the selected command or button.
25
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The Status bar also displays the following information about the 
data CD project:

■ Number of files and folders in the data CD project

■ Type of CD (Double-click this field to display the CD Project 
Properties dialog box.)

■ File System Option—Joliet or ISO 9660 (Double-click this field 
to display the CD Project Properties dialog box.)

■ CD-Recorder (Double-click this field to display the CD Drive 
Properties dialog box.)

■ Write Method—Disc-at-Once or Track-at-Once (Double-click 
this field to change between DAO and TAO.)

To hide or show the Status bar:

■ From the View menu, select Status Bar. 

Viewing the CD Info Bar
The CD Info bar at the bottom of the data CD project displays the 
amount of free space available (in MBs) on the CD. 

To show or hide the CD Info bar:

■ From the View menu, select CD Info Bar.

CD Info Bar
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Erasing a CD
To erase the contents of a CD-RW disc in your CD-ReWritable drive:

Note: You cannot erase the contents of a CD-R disc. 

1 From the Source window, select the CD-ReWritable drive that 
contains the CD-RW disc you want to erase.

2 From the CD menu, select Erase Disc.

Validating a CD Project
Validating a CD project allows you to verify that the source contents 
have not been moved, deleted, renamed, or modified since you 
added them to the CD project. If an item cannot be found, you are 
prompted to delete the item from the CD project before recording 
the CD project.

To validate a CD project:

■ From the File menu, select Validate Project.

Advanced Data CD Topics

Making a Multisession CD
A session is a recorded area on a CD containing one or more music 
or data tracks. A CD can have either a single session (as is the case 
with most music CDs) or multiple sessions, which are called 
multisession CDs.

Note: A multisession music CD is not recommended. Only 
the tracks recorded in the first session are playable on most 
home or car stereo CD players.
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To make a multisession CD:

1 To record the first session, follow the instructions in Making a 
Data CD on page 23. Before you start recording, do the 
following:

■ In the CD Project Properties dialog box (from the File menu, 
select CD Project Properties), select Mode 2: CD-ROM XA.

■ In the Record CD Setup dialog box (displayed when you 
click Record) under Options, select Track-at-Once and 
Finalize Session. Don’t Finalize CD as the record method.

2 When you are ready to add another session to the CD, make 
sure the CD is inserted in the default CD-Recorder. Before you 
add data to the CD project, do the following:

■ In the CD Project Properties dialog box, select 
Automatically Import Previous Session. This links the new 
session to the last session recorded to the CD.

3 Follow the instructions again in Making a Data CD on page 23. 
When you add data to the CD project, the data from the 
previous session is automatically imported into your CD 
project.

4 Continue with the instructions in Making a Data CD.

Manually Importing a Session
To import a specific session on a multisession CD into your data CD 
project, follow these steps:

1 Insert the multisession CD into the default CD-Recorder.

2 From the CD menu, select Import Session.

3 Select the session you want to import from the list and click 
Import.

Note: Importing a session other than the last session 
recorded to the CD may cause you to lose access to the 
sessions not imported.
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Making a Bootable CD
With Easy CD Creator, you can make a bootable CD that can be used 
to start your computer. A bootable CD contains a bootable image, a 
file that is an exact representation of a bootable floppy disk or hard 
disk. To make a bootable CD, you will need a bootable floppy disk 
or hard disk image.

Note: Making a bootable CD is intended for the advanced 
user. It requires an understanding of how to create bootable 
floppy and hard disks, and how to create and edit DOS 
config.sys and autoexec.bat files.

To make a bootable CD, follow the instructions in each of the 
following sections.

Verify That Your System Supports Bootable CD

To start your system from a bootable CD, the system itself must 
support the bootable CD feature. Here is what you need to verify:

■ Check your system BIOS settings and look for the Bootable 
CD-ROM support option. If it is available, enable the option. 
Most Pentium-class systems (or higher) support this feature. 

■ If your CD-ROM drive is connected to a SCSI host adapter, and 
if the SCSI host adapter has a BIOS onboard, check your host 
adapter’s documentation to verify that the adapter supports 
bootable CD. If bootable CD support is available, make sure it 
is enabled for the adapter.

Make a Bootable CD with Easy CD Creator

To make a Bootable CD:

1 Insert a blank CD into your CD-Recorder (the destination 
drive).

2 Start a new bootable CD project. From the File menu, point to 
New CD Project then select Bootable CD. The Choose Type of 
Bootable CD dialog box appears.
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3 Select the Bootable CD Type:

■ Floppy Disk Emulation (1.44 MB): Select this option if you 
want a bootable CD that allows you to boot your system 
under a specific operating system, and then load a device 
driver that understands the true format of the CD, usually 
ISO 9660. (Requires a bootable floppy disk. See Create a 
Bootable Floppy Disk on page 31.)

■ Floppy Disk Emulation (2.88 MB): Select this option if you 
want a bootable CD that allows you to boot your system 
under a specific operating system, and then load a device 
driver that understands the true format of the CD, usually 
ISO 9660. (Requires a bootable floppy disk. See Create a 
Bootable Floppy Disk on page 31.)

■ Hard Disk Emulation: Select this option if you want to 
provide a large MS-DOS compatible CD-ROM storage space 
on which programs may reside and access data.

■ No Emulation: Select this option if you do not want the CD 
to emulate a floppy or hard disk.

4 Select the emulation appropriate for the Bootable CD Type 
selected above.

5 Click OK. Follow any on-screen instructions that may appear.

6 When the bootable CD project appears, use Easy CD Creator as 
you normally would for making a data CD.

Note: When the CD has been made, take it to the system you 
want to boot from. Make sure it has bootable CD-ROM 
support enabled, insert the bootable CD in your CD-ROM 
drive, and reboot the system. If you are able to start your 
system from the bootable CD, you have successfully made a 
bootable CD.
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Create a Bootable Floppy Disk

The floppy disk you need to create is dependent on the system you 
are planning to boot from. The floppy disk needs to be formatted 
with the DOS Format command (FORMAT A: /S) and also contain a 
config.sys and autoexec.bat file.

The config.sys file typically contains the instructions to load your 
DOS CD-ROM driver while the autoexec.bat file contains the 
instructions to load Microsoft’s DOS CD-ROM Extensions (i.e. 
mscdex.exe).

Please consult your system’s documentation for the proper way to 
load your DOS CD-ROM driver and mscdex.exe. You should test 
this configuration with your bootable floppy disk before you make a 
bootable CD. If your target system boots properly with the floppy 
disk, and assigns a drive letter for the CD-ROM drive on that 
system, you are ready to make a bootable CD.

Note: When you add the command lines to the config.sys 
and autoexec.bat, do not use fixed paths. For example:

Recommended Entry: device=aspicd.sys /d:aspicd0
Not Recommended: device=a:\aspicd.sys /d:aspicd0
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Making Data CDs Using 
DirectCD
In This Chapter

Getting Started with DirectCD
DirectCD formats a CD-Recordable (CD-R), CD-ReWritable 
(CD-RW), or DVD-Recordable disc so you can directly copy files to 
it in much the same way that you copy files to a floppy disk or 
removable drive. You can then use Windows Explorer, or any other 
program that can read from and write to a drive letter, to copy files 
to a CD.
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DirectCD provides a file system based on UDF v.1.5 and writes data 
to the CD using packet writing technology. This file system gives 
you drive letter access to your CD-Recorder.

Once your CD is formatted, you can copy files to it using drag and 
drop in Windows Explorer, as well as other methods. See Copying 
Methods on page 44.

Understanding CD-R and CD-RW Technology
If you are new to making your own data CDs, the following sections 
will help you understand some of the related terms and 
technologies.

About CD-ReWritable Technology
If you have a CD-ReWritable drive, you can use two types of CDs to 
make your own CDs: 

■ CD-Recordable (CD-R) discs

■ CD-ReWritable (CD-RW) discs

CD-RW is a technology that, like CD-R, allows you to record 
information to a CD. The difference is that with CD-RW you can also 
erase the contents of a CD and rewrite new information to it. 
Depending on how you want to use your CD, each CD type offers 
unique advantages.

Note: Only CD-RW and MultiRead CD-ROM drives can read 
CD-RW discs, and only CD-RW drives can write data to 
CD-RW discs.

About UDF v.1.5
Universal Disk Format version 1.5 is a file system standard that 
enables a CD-Recorder to be used as a logical device on a computer 
system. In other words, UDF lets you read files from and write files 
to a CD in your CD-Recorder, just as you would read and write files 
to a floppy disk or a hard disk. 

If you have DirectCD 5.0 installed, you automatically have the UDF 
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CD using DirectCD, it automatically copies the UDF Reader for 
Windows to the CD. When you insert the CD into a drive, the reader 
will automatically ask if you want to install it. 

UDF v.1.5–compatible readers are available for most common 
operating systems and must be installed for CD-Recorders to read 
UDF v.1.5–formatted CDs.

Uses for DirectCD
DirectCD is the easiest way to copy data files directly to a CD. Some 
uses for DirectCD include:

■ Archiving data

■ Backing up a hard disk 

■ Disseminating information to field offices

■ Transferring and distributing data to other Windows systems

■ Distributing databases

You should use CD mastering software, such as Easy CD Creator, to 
make CDs when you want to make:

■ A test copy of a CD before having it factory-duplicated

■ CDs that can be read on different operating systems such as 
DOS or Windows 3.x

■ Music CDs

■ Special data CDs, such as enhanced CDs 

Refer to your CD mastering software’s Online Help for more 
information.

Starting DirectCD
Choose one of these ways to start DirectCD so you can begin 
copying files to your CD:

■ From the Easy CD Creator Project Selector window, click Make 
a Data CD, then click DirectCD.

■ On the Windows taskbar, click Start, point to Programs, point 
to Roxio Easy CD Creator 5, point to Applications, and select 
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■ Double-click the DirectCD icon  on the Windows taskbar.

■ Insert a CD-R, CD-RW, or DVD-Recordable disc that you 
already formatted using DirectCD or another UDF v.1.5–
compatible program into your CD-Recorder. After a few 
seconds, the CD Ready dialog box appears. This tells you that 
you can now read and write your files using any program that 
can read from and write to a drive letter.

The DirectCD main window appears, where you can format a CD 
for drag and drop file copying.

Understanding the DirectCD Main Window
The DirectCD main window gives you access to DirectCD’s 
functions and displays information about the selected CD-Recorder 
and CD. From here you can format a CD, which prepares the CD for 
file copying. After you format a CD, you copy files to the CD using 
Windows Explorer or other Windows programs. See Copying 
Methods on page 44.
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■ Select CD: Select the CD-Recorder that contains the CD you 
want to work with. If you have only one CD-Recorder 
installed, that CD-Recorder is automatically selected for you. If 
the CD-Recorder you want to use is not listed, be sure that it is 
properly installed or check the Roxio Website for drive support 
updates.

■ CD Info: Displays the following information about the CD in 
the selected CD-Recorder: 

■ Status: Current state of the CD. Refer to the Online Help for 
information about the Status and Type. 

■ Label: Name you typed to identify the CD.

■ Free Space: Amount of space (in MB) that is available for 
use on the CD.

■ Total Space: Amount of data (in MB) that the CD can store.

■ Type: Type of CD. Refer to the Online Help for information 
about the Status and Type. 

■ Compressed: Compression status of the CD: Yes or No.

■ Used By: Program that is currently using the CD.

■ Format CD: Displays the Format dialog box, where you can 
format a new, unused CD. Formatting a CD prepares it to 
accept files. You can also format a previously used CD-RW or 
DVD-Recordable disc, which makes any existing files on the 
CD unavailable. See Copying Files to a CD-R Disc for the First 
Time on page 39, Copying Files to a CD-RW Disc for the First Time 
on page 40, Copying Files to a DVD-Recordable Disc for the First 
Time on page 43.

■ Eject: Ejects the CD from the currently selected CD-Recorder. 
Depending on the type of CD and the options you have 
selected, the Eject Options dialog box may appear. See Ejecting 
a CD-R Disc on page 45, Ejecting a CD-RW or DVD-Recordable 
Disc on page 48.

■ CD Utilities: Displays the Utilities dialog box, where you can 
access ScanDisc. See Checking CDs for Problems on page 52.

■ Erase CD: Allows you to erase the contents of a CD-RW or 
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■ Make Writable: Allows you to add files to a CD-R disc that 
was made using Easy CD Creator with the Close Session and 
Leave CD Open option. You must make the CD writable before 
you can add more files to the CD. See Adding More Files to an 
Easy CD Creator CD-R Disc on page 50.

■ Web-CheckUp: Launches your computer’s Internet browser 
and automatically goes to a software update Website. 

■ Options: Displays the Options dialog box, where you can 
change DirectCD’s options. See Changing DirectCD’s Options on 
page 37.

Changing DirectCD’s Options
DirectCD allows you to customize several options. 

To change options:

1 From the Select CD drop-down list box on the DirectCD main 
window, select the CD-Recorder you want.

2 Click Options. The Options dialog box appears.
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3 Change the options, as needed.

The selected options apply whenever you use DirectCD on this 
computer.

Setting Description

Show the CD 
Ready 
Notification

Select this option if you want the CD Ready 
dialog box to notify you that the CD is ready. This 
tells you that the CD is ready for direct read and 
write access when you insert a CD formatted by 
DirectCD into your CD-Recorder.

Show the 
Ejected CD 
Notification

Select this option if you want the CD Ejected 
dialog box to notify you each time you eject a CD 
using DirectCD.

Show Icon in 
Taskbar

Select this option if you want the DirectCD icon 

 to appear in the Windows taskbar. Double-
click or right-click the icon to access DirectCD’s 
functions.

CD-R Eject 
Options

For more information, see Ejecting a CD-R Disc on 
page 45 and Comparing the CD-R Eject Options on 
page 47.

Always 
Leave As 
Is

Select this option if you want DirectCD to 
automatically leave the CD as it is so that it can be 
read and written through drive letter access in the 
future when you click Eject. Only computers with 
CD-R or CD-RW drives can read the CD.

Always 
Show Eject 
Options 
Dialog Box

Select this option if you want DirectCD to 
automatically display the Eject Options dialog 
box when you click Eject, letting you select the 
eject option you want to use each time.

Always Close

Close to 
UDF v.1.5

Select this option if you want DirectCD to 
automatically close the CD to the UDF v.1.5 
format when you click Eject. The CD can then be 
read on most CD-ROM drives after installing the 
UDF Reader.

Close to 
Read on 
Any 

Select this option if you want DirectCD to 
automatically close the CD to the ISO 9660 
standard when you click Eject. The CD can then 
38

Computer be read automatically in most standard CD-ROM 
drives under Windows.



Making Data CDs Using DirectCD

4 Change the Options Available for Drive [letter], as needed.

These options apply only to the CD-Recorder you selected on 
the DirectCD main window.

■ Label: Type a new name to identify your CD or keep the 
same name. The CD label can be up to 11 characters. You 
cannot use the following characters in a label: \ / : ; * ? " < > 
| + = . , [ ].

Note: You should be sure that the CDs you are using are 
rated for the speed of the drive. You do not normally need to 
change the read or write speeds.

■ Read Speed: Displays the current read speed of the drive. 
You may want to change the read speed to be closer to your 
write speed if you are writing a lot of data to the CD. Refer 
to the Online Help for additional information about 
changing the read speed.

■ Write Speed: Displays the current write speed of the drive. 
You may want to change the write speed to match the speed 
rating of the CD. If you make a CD and then cannot read it 
in the same drive, try lowering the write speed and writing 
the data again. Refer to the Online Help for additional 
information about changing the write speed.

5 Click OK.

Copying Files to a CD
Before you can copy files to a blank CD, you must format it. The 
format options available vary based on the type of CD you are 
using. The following sections describe copying files for the first time 
and the various file copying methods you can use.

Copying Files to a CD-R Disc for the First Time
Before you can copy files to a CD-R disc, you must format it. 

Note: The Format CD button is not available for a previously 
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To format a CD-R disc:

1 Insert a blank CD-R disc into your CD-Recorder.

2 From the Select CD drop-down list box on the DirectCD main 
window, select the CD-Recorder that has the CD you want to 
format.

3 Click Format CD. The Format dialog box appears.

4 In the Label text box, type a name to identify your CD.

The CD label can be up to 11 characters. You cannot use the 
following characters in a label: \ / : ; * ? " < > | + = . , [ ].

If you are formatting a CD-R disc, you have no Format Type 
options available and the formatting takes 15 to 30 seconds.

5 Click Start Format. CD formatting begins and a progress 
dialog box appears.

You can do other tasks on your computer while the CD is being 
formatted. The CD Ready dialog box appears when formatting 
is complete.

6 Click OK. The CD is ready for you to copy files to. See Copying 
Methods on page 44.

Copying Files to a CD-RW Disc for the First Time
Before you can copy files to a CD-RW disc, you must format it. 

You can also format the CD to erase its data. Using Quick Format for 
this purpose only deletes the internal directory where the files are 
listed. You can no longer see or access the files, but the files are still 
stored on the CD.

To format or erase a CD-RW disc:

1 Insert a blank CD-RW disc into your CD-Recorder.

2 From the Select CD drop-down list box on the DirectCD main 
window, select the CD-Recorder you want.

3 Click Format CD. The Format dialog box appears.

4 In the Label text box, type a name to identify your CD.
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The CD label can be up to 11 characters. You cannot use the 
following characters in a label: \ / : ; * ? " < > | + = . , [ ].

5 If you want to enable data compression on the CD, select the 
Enable Compression option.

Compression makes your files take up less space on the CD. 
Once a CD has been formatted using compression, all data will 
be compressed on the CD. The compression ratio varies from 
approximately 1.5:1 to approximately 3:1, depending on the 
type of files you copy to the CD. 

To read the CD, you must either have DirectCD 5.0 installed or 
have the UDF Reader installed. When you make a CD using 
DirectCD, it automatically copies the UDF Reader for 
Windows to the CD. When you insert the CD in a CD-
Recorder, the reader will automatically ask if you want to 
install it. To write to the CD using other CD-Recorders in other 
computers, you must use DirectCD 5.0.

6 Select the Format Type you want to use.

■ If you are formatting a blank CD-RW disc, you may have 
two options:

■ Fast Format: Fast format is a special type of formatting 
supported only on some CD-RW drives. The option is 
available only if your drive supports it. Fast format 
allows you to start using the CD in 3 to 7 minutes, while 
the remaining formatting is done in the background. 
Background formatting takes up to 90 minutes to 
complete, depending on the speed of the CD-Recorder 
and what other work the computer is doing at the time. 
You can safely interrupt fast formatting by ejecting the 
CD. When you reinsert the CD into a CD-RW drive that 
does not support fast format, you can read the CD, but 
you cannot write data to it until formatting is complete. 
When you reinsert the CD into a drive that supports fast 
format, the formatting continues from where it left off 
and you can write data to the CD.

■ Full Format: Full format takes about 60 minutes for a 2x 
drive and about 15 minutes for an 8x drive. It verifies the 
integrity of the CD surface, prepares the CD for data, and 
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■ If you are formatting a CD-RW disc that has been fully 
formatted before, you have two options:

■ Quick Format: Quick format takes only a few minutes. It 
writes the DirectCD file system to the CD, but does not 
verify the physical condition of the CD. Any files that 
were on the CD will not be accessible, but they are still on 
the CD.

■ Full Format: Same as described for the Full Format 
option above. Any data that was on the CD will be 
completely erased.

7 Click Start Format. CD formatting begins and a progress 
dialog box appears.

You can do other tasks on your computer while the CD is being 
formatted. The CD Ready dialog box appears when complete.

8 Click OK. The CD is ready for you to write information to it. 
See Copying Methods on page 44.
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Copying Files to a DVD-Recordable Disc for the First Time
Before you can copy files to a DVD-Recordable disc, you must 
format it. 

You can also format the disc to erase its data. Using Quick Format 
for this purpose only deletes the internal directory where the files 
are listed. You can no longer see the files, but the files are still there.

To format a DVD-Recordable disc:

1 Insert a blank DVD-Recordable disc into your 
DVD-Recordable drive.

2 From the Select CD drop-down list box on the DirectCD main 
window, select the disc you want.

3 Click Format CD. The Format dialog box appears.

4 In the Label text box, type a name to identify your disc.

The label can be up to 11 characters. You cannot use the 
following characters in a label: \ / : ; * ? " < > | + = . , [ ].

5 If you want to enable data compression on the disc, select the 
Enable Compression option.

Compression makes your files take up less space on the disc. 
Once a disc has been formatted using compression, all data 
will be compressed on the disc. The compression ratio varies 
from approximately 1.5:1 to approximately 3:1, depending on 
the type of files you copy to the disc. 

To read the disc, you must either have DirectCD 5.0 installed or 
have the UDF Reader installed. When you make a disc using 
DirectCD, it automatically copies the UDF Reader for 
Windows to the disc. When you insert the disc in a 
DVD-Recordable drive, the reader will automatically ask if 
you want to install it. To write to the disc using other 
DVD-Recordable drives in other computers, you must use 
DirectCD 5.0.

6 Select the Format Type you want to use:

■ If you are formatting a blank DVD-RW or DVD+RW disc, 
you have only one option:
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■ Full Format: Full format takes about one hour for a 1x 
drive. It verifies the integrity of the disc surface, prepares 
the disc for data, and writes the UDF file system to the 
disc. DVD+RW will perform a background format. This 
allows the user to use the disc while this process occurs in 
the background.

■ If you are formatting a previously used DVD-Recordable or 
a blank DVD-RAM disc, you have two options:

■ Quick Format: Quick format takes only a few minutes. It 
writes the DirectCD file system to the disc, but does not 
verify the physical condition of the disc. Any files that 
were on the disc will not be accessible, but they are still 
on the disc.

■ Full Format: Same as described for the Full Format 
option above. Any data that was on the disc will be 
completely erased.

7 Click Start Format. Disc formatting begins and a progress 
dialog box appears.

You can do other tasks on your computer while the disc is 
being formatted. The CD Ready dialog box appears when 
formatting is complete.

8 Click OK. The disc is ready for you to copy files to. See Copying 
Methods on page 44.

Copying Methods
Once your CD is formatted and ready for data, you can copy files to 
it a number of ways:

■ In Windows Explorer, drag and drop files onto the 

CD-Recorder drive letter (it has an icon like this ).

■ Select Save As from any Windows program’s File menu and 
select the drive letter of your CD-Recorder.

■ Use the Send To command by right-clicking a file in Windows 
Explorer and then selecting the drive letter of your 
CD-Recorder from the pop-up menu.
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Ejecting a CD
You must eject a CD to remove it from your CD-Recorder. The 
options available for ejecting a CD depend on the type of CD you are 
using. The following sections describe ejecting CDs.

Ejecting a CD-R Disc
When you eject a CD-R disc, you have three options. The option you 
select depends on how you plan to use the CD.

To eject a CD-R disc:

1 From the Select CD drop-down list box on the DirectCD main 
window, select the CD-Recorder you want.

2 Click Eject, or from Windows Explorer, right-click the 
CD-Recorder drive letter and select Eject.

If the Show Eject Options Dialog Box option is turned on, the 
Eject Options dialog box appears. 

If the Show Eject Options Dialog Box option is turned off, 
DirectCD ejects the CD immediately using the option selected 
under CD-R Eject Options. See Changing DirectCD’s Options on 
page 37.

3 If the Eject Options dialog box appears, select the option you 
want:

■ Leave As Is: Leave the CD as it is so it can be read and 
written to as a drive letter. Standard CD-ROM drives will 
not be able to read the CD. 

■ Only computers with CD-R or CD-RW drives can read 
the CD.

■ Use this option when you plan to keep adding files to the 
CD and you do not need to give the CD to someone else 
to use. 
45



Making Data CDs Using DirectCD

■ Close to UDF v.1.5: Close the CD to the UDF v.1.5 format so 
that it can be read on most CD-ROM drives after installing a 
UDF v.1.5 reader. 

■ Use this option when you need to give the CD to 
someone who has DirectCD 5.0 installed or who you 
know has a UDF v.1.5–compatible reader installed. This 
option uses less space on the CD for each session than 
described in the Note below for ISO 9660. 

■ When you make a CD using DirectCD, it automatically 
copies the UDF Reader for Windows to the CD. When 
you insert the CD into a CD-ROM drive, the reader will 
automatically ask if you want to install it. 

■ Close to Read on Any Computer: Close the CD so that it 
can be read automatically in most standard CD-ROM 
drives. 

■ Use this option when you need to give the CD to 
someone else to use and that person may not have a UDF 
v.1.5–compatible reader installed. CD-ROM drives under 
other operating systems, such as Unix, Linux, and 
Macintosh, can also read the CD without using any 
special reader. 

Note: This closes the CD to the ISO 9660 standard. The ISO 
9660 information requires approximately 22 MB of space on 
the CD for the first session, and approximately 13 MB for 
each additional session. 

4 If you selected the Close to Read on Any Computer option, 
you can also select the Protect CD So It Cannot Be Written To 
Again option.

Selecting this option permanently closes the CD so you can 
never copy more files to the CD.

5 Click Eject.

DirectCD ejects the CD using the option you selected. 

For more information about the eject options, see Comparing the 
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Comparing the CD-R Eject Options
When you eject a CD-R disc, you have three different options you can 
use. Which option you use depends on how you plan to use the CD. 
The table below summarizes the key characteristics of each option.

Note: You must have the Show Eject Options Dialog Box 
option selected to see the following options when you eject 
a CD, or you can select one as the default option. See 
Changing DirectCD’s Options on page 37.

Setting Use of Space
File Name and 
Path Length

Read-Only Setting 
on Files

Leave As Is Uses no addi-
tional space on 
the CD.

No limits other 
than those of 
the Windows 
operating sys-
tem.

Does not change 
files on the CD 
to read-only.

Close to Read 
on Any 
Computer

Uses approxi-
mately 22 MB of 
space on the CD 
for the first ses-
sion, and 13 MB 
for each addi-
tional session.

Limits file 
names to 64 
characters and 
the path to 8 
folders and 
subfolders.

Changes files on 
the CD to read-
only. You can 
change the read-
only setting after 
copying the file 
to another com-
puter by right-
clicking the file 
in Windows 
Explorer and 
selecting Proper-
ties.

Close to UDF 
v.1.5

Uses less space 
than Close to 
Read on Any 
Computer for 
each closed ses-
sion.

Limits file 
names to 64 
characters and 
the path length 
to a total of 248 
characters.

Does not change 
files on the CD 
to read-only.
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Ejecting a CD-RW or DVD-Recordable Disc
When you eject a CD-RW or DVD-Recordable disc, you have no 
options to select. DirectCD ejects the CD immediately. 

Reading CDs
Where you can use a CD depends on the type of CD and the eject 
option you select. The following sections describe where you can 
read each type of CD.

Reading CD-R Discs
Where you can use a CD-R disc depends on the option you select 
when you eject the CD. You have three options available when you 
eject CD-R discs. 

Note: You must have the Show Eject Options Dialog Box 
option selected to see the following eject options when you 
eject a CD. See Changing DirectCD’s Options on page 37.

■ Leave As Is: This leaves the session open and in UDF v.1.5 
format. You can read this CD on computers that have one of 
the following configurations:

■ CD-R or CD-RW drive with DirectCD 5.0 installed.

■ CD-R or CD-RW drive with a UDF v.1.5–compatible 
reader installed. When you make a CD using DirectCD, it 
automatically copies the UDF Reader for Windows to the 
CD. When you insert the CD into a drive, the reader will 
automatically ask if you want to install it. 

■ MultiRead CD-ROM drive with a UDF v.1.5–compatible 
reader installed. When you make a CD using DirectCD, it 
automatically copies the UDF Reader for Windows to the 
CD. When you insert the CD into a drive, the reader will 
automatically ask if you want to install it. 
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■ Close to UDF v.1.5: This closes the session, but leaves the 
CD in UDF v.1.5 format. You can read this CD on computers 
that have one of the following configurations:

■ CD-R or CD-RW drive with DirectCD 5.0 installed.

■ CD-R or CD-RW drive with a UDF v.1.5–compatible 
reader installed. When you make a CD using DirectCD, it 
automatically copies the UDF Reader for Windows to the 
CD. When you insert the CD into a drive, the reader will 
automatically ask if you want to install it. 

■ Most CD-ROM drives with a UDF v.1.5–compatible 
reader installed. When you make a CD using DirectCD, it 
automatically copies the UDF Reader for Windows to the 
CD. When you insert the CD into a CD-ROM drive, the 
reader will automatically ask if you want to install it. 

■ Close to Read on Any Computer: This closes the CD to the 
ISO 9660 standard. CD-ROM drives under Windows and 
other operating systems, such as Unix, Linux, and 
Macintosh, can read the CD. No reader is needed to read the 
CD.

For more information about the eject options, see Comparing the 
CD-R Eject Options on page 47.

Reading CD-RW Discs
Only CD-RW drives and MultiRead CD-ROM drives can read a 
CD-RW disc.

Reading DVD-Recordable Discs
DVD-Recordable drives can only read DVD-Recordable discs 
manufactured specifically for the type of DVD-Recordable drive. For 
example, only DVD-RAM drives can read a DVD-RAM disc, and 
only DVD-RW drives can read a DVD-RW disc.

Adding and Erasing Files
After you copy files to a CD, you can add more files to it or erase the 
files.
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Adding More Files to an Easy CD Creator CD-R Disc
If you are using CD-R discs that you made using Easy CD Creator 
with the Close Session and Leave CD Open option, you must make 
the CD writable before you can add more files to the CD.

To add more files to an Easy CD Creator CD-R disc:

1 Insert the CD into your CD-Recorder.

2 From the Select CD drop-down list box on the DirectCD main 
window, select the CD-Recorder you want.

3 Click Make Writable. The Make Writable dialog box appears.

4 Type a new Label if needed.

The CD label can be up to 11 characters. You cannot use the 
following characters in a label: \ / : ; * ? " < > | + = . , [ ].

5 Click Make Writable and wait until the CD Ready dialog box 
appears.

You can now add more files to the CD using Windows Explorer or 
other Windows programs. See Copying Methods on page 44.

Adding More Files to All Other CDs
If you previously formatted a CD-R, CD-RW, or DVD-Recordable 
disc using DirectCD, you can add more files to it until the CD is full. 

If you are using CD-R discs that you made using Easy CD Creator 
and the Close Session and Leave CD Open option, see Adding More 
Files to an Easy CD Creator CD-R Disc on page 50.
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To add more files to a CD:

1 Insert the CD into your CD-Recorder.

2 If you selected the Show CD Ready Notification option, wait 
for the CD Ready dialog box to appear and click OK. See 
Changing DirectCD’s Options on page 37.

3 Continue copying files to your CD. See Copying Methods on 
page 44.

Erasing a CD
You can use the Erase CD function on CD-RW and DVD-Recordable 
discs to erase the internal directory that lists the files on the CD, 
making the files inaccessible. You must format the CD again before 
you can copy files to it. See Copying Files to a CD-RW Disc for the First 
Time on page 40 and Copying Files to a DVD-Recordable Disc for the 
First Time on page 43.

Note: You cannot use the Erase CD function on a CD-R disc. 

To erase the contents of a CD:

1 Insert the CD into your CD-Recorder.

2 From the Select CD drop-down list box on the DirectCD main 
window, select the CD-Recorder you want.

3 Click Erase CD.

DirectCD confirms that you want to delete all data from the 
CD and that the erase operation will take several minutes to 
complete.

4 Click Yes to confirm that you want to erase the CD. DirectCD 
erases the entire contents of the CD.

Deleting Individual Files
You can delete individual files from a CD using Windows Explorer. 
When you delete files from CD-RW or DVD-Recordable discs, you 
free up space on the CD. 
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When you delete files from a CD-R disc, you only delete the internal 
directory where the files are listed. You can no longer see the files on 
the CD, but you do not actually free up space on the CD.

To delete individual files:

1 Insert the CD into your CD-Recorder.

2 In Windows Explorer, right-click the file or files you want to 
delete.

3 Select Delete from the pop-up menu. Explorer confirms that 
you want to delete the selected files.

4 Click Yes to delete the selected files.

Checking CDs for Problems
ScanDisc allows you to recover files from a CD created with 
DirectCD if the CD is not working properly. ScanDisc has a good 
chance of recovering several types of files, including:

■ Files not visible in Windows Explorer: The writing process 
was interrupted before file directory information was 
completed, but most or all of the files were written to the CD. 
This means that the files may be on the CD, but Windows 
Explorer cannot see them.

■ Damaged files: Files that have unreadable sections in them 
because of damage to the CD.

■ Lost files: Complete files that do not have a file name 
associated with them. They can also be files that you deleted 
from the CD.

Some files may be so damaged that ScanDisc cannot recover them. 
ScanDisc attempts to report the names of any such files.

ScanDisc can also repair a damaged CD, making some or all of it 
usable again. 
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Use ScanDisc when any of the following happens with a CD-R, 
CD-RW, or DVD-Recordable disc when it is in a CD-Recorder:

■ You cannot see some, or any, of the files on the CD using 
Windows Explorer.

■ You cannot open a file on the CD with the software that you 
used to create the file.

■ The process of writing files to the CD was interrupted by a 
system or power failure.

■ DirectCD reports a CD status of Unrecognized Data.

Starting ScanDisc
To start ScanDisc:

1 Insert the CD into your CD-Recorder.

2 From the DirectCD main window, click CD Utilities. The 
Utilities dialog box appears.

3 Click ScanDisc. The ScanDisc dialog box appears.

4 Click Scan to start the ScanDisc process. ScanDisc starts 
checking the CD and the ScanDisc Progress dialog box appears.

If ScanDisc finds problems on the CD, it asks if you want to 
scan the CD for the information needed to recover files and 
repair the CD.

5 Click Yes. 

ScanDisc starts scanning the CD and the ScanDisc Progress 
dialog box appears. For information about the Status, refer to 
the Online Help.

If ScanDisc finds files on the CD that you can recover, it asks if 
you want to recover them. See Recovering Files on page 55.

If ScanDisc does not find files to recover, it continues with the 
scanning process.
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Understanding the ScanDisc Process
After you start ScanDisc, it reads your CD and looks for specific 
problems and shows its progress for each of the following steps in 
the process:

1 Checking the CD: ScanDisc checks if it can read the CD, that 
is, can it see the list of files and folders on the CD.

2 Getting CD Information: If ScanDisc cannot see the files and 
folders on the CD, it gathers information about the CD. This 
can take several minutes or more.

a After gathering the information, ScanDisc asks if you want 
to recover the files on the CD. We strongly recommend that 
you do this if you need to access the files. See Recovering 
Files on page 55.

b If you decide to recover the files, ScanDisc allows you to 
select the folders and files to recover and where you want to 
copy them.

c If ScanDisc finds damaged files during the recovery process, 
it displays a list of the damaged files it recovered. See 
Recovering Lost Files on page 56.

3 Finding Lost Files: ScanDisc looks for lost files and allows you 
to copy any lost files it finds to another location. See Recovering 
Lost Files on page 56.

4 Repairing the CD: ScanDisc tries to repair the CD so that you 
can use it again. After the repair, the files that were on the CD 
may not be available and the CD may have less space for new 
files. ScanDisc may not be able to repair badly damaged CDs. 
See Repairing CDs on page 57.
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5 Checking File Integrity: ScanDisc looks for damaged files. If it 
finds none, ScanDisc reports that it is done.

a If it finds damaged files, it asks you if you want to copy the 
damaged files to another location (such as a hard disk or 
floppy disk). ScanDisc cannot repair damaged files, so they 
will be reported each time you run ScanDisc on the CD. See 
Recovering Damaged Files on page 58.

b After copying the damaged files, ScanDisc reports that it is 
done.

Recovering Files
If ScanDisc finds that the CD has problems and that there are 
recoverable files on the CD, it asks if you want to attempt to recover 
the files from the CD. We strongly recommend that you recover all 
files that have data you need. If you do not, the files may not be 
accessible after ScanDisc repairs the CD later in the process.

To recover files:

1 Click Yes when ScanDisc asks if you want to attempt to recover 
files. The File Recovery dialog box appears.

2 From the Source Folders list, select a folder that has files you 
want to recover.

By default, all files and folders listed are selected.

3 From the Source Files list, deselect the files you do not want to 
recover. 

4 From the Destination Drive drop-down list box, select where 
you want to copy the files. 

You can select any drive on your computer except the 
CD-Recorder you are recovering the files from. If you want to 
copy the files to another computer on your network, you must 
map the drive first. Refer to your operating system’s 
documentation about mapping drives.
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5 From the Destination Folder list, select the folder where you 
want to copy the files.

If you want to create a new folder, click New Folder  and 
type a name for the folder.

6 Click Copy. 

ScanDisc copies the selected files to the location you selected 
and the File Copy Progress dialog box appears. 

If ScanDisc finds damaged files, it lists the file names.

7 Click Done. The File Recovery dialog box appears.

8 Repeat Steps 2–7 as many times as needed to copy all of the 
files you need from the CD.

9 From the File Recovery dialog box, click Done to proceed to 
the repair process.

Recovering Lost Files
If ScanDisc finds lost files during the recovery process, it asks if you 
want to recover the files. 

We strongly recommend that you recover all files that may have data 
you need. If you do not, the files may not be accessible after 
ScanDisc repairs the CD later in the process.

To recover lost files:

1 Click Yes when ScanDisc tells you that it has found files that 
have no file name. The Select a Destination dialog box appears.

2 From the Destination Drive drop-down list box, select where 
you want to copy the files.

You can select any drive on your computer except the 
CD-Recorder you are recovering the files from. If you want to 
copy the files to another computer on your network, you must 
map the drive first. Refer to your operating system’s 
documentation about mapping drives.

3 From the Destination Folder list, select the folder where you 
want to copy the files.
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4 Click Copy. The File Copy Progress dialog box appears and 
shows ScanDisc’s progress. 

ScanDisc copies the lost files to the location you selected. The 
lost files are given unique, sequentially numbered file names 
starting with sd000001.rec.

Lost files may also be damaged. If ScanDisc finds damaged lost 
files, it lists them with their unique names (sd000001.rec) in 
the Damaged Files dialog box. ScanDisc copies the damaged 
lost files to the location you selected, but it adds blank spaces 
where the data could not be read. You may still be able to open 
these files with the original application that you used to create 
them, or you may have to try other strategies. See Repairing 
CDs on page 57.

5 Click Done to proceed to the repair process. A message 
appears letting you access information about the lost files.

6 Click Continue to continue the ScanDisc process. See Repairing 
CDs on page 57.

Repairing CDs
After letting you recover files from a damaged CD that you made 
using DirectCD, ScanDisc asks if you want to repair the CD so that it 
is usable. If you click Yes, ScanDisc tries to make the CD usable. 

Note: After repairing a CD, the files that were on it may no 
longer be accessible. ScanDisc cannot repair all damaged 
CDs.

To repair a CD: 

1 Click Yes when ScanDisc asks if you want to repair the CD. 
ScanDisc repairs the CD and the ScanDisc Progress dialog box 
appears.

After completing the repair, ScanDisc may check the integrity 
of the files on the CD.

2 Click Done.
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Recovering Damaged Files
After ScanDisc repairs the CD, it checks the integrity of each file on 
the CD looking for damaged files. If it finds damaged files, it asks 
you if you want to copy the damaged files to another location (such 
as a hard disk or floppy disk).

To recover damaged files:

1 Click Yes when ScanDisc tells you that it has found damaged 
files. The Select a Destination dialog box appears.

2 From the Destination Drive drop-down list box, select where 
you want to copy the files.

You can select any drive on your computer except the 
CD-Recorder you are recovering the files from. If you want to 
copy the files to another computer on your network, you must 
map the drive first. Refer to your operating system’s 
documentation about mapping drives.

3 From the Destination Folder list, select the folder where you 
want to copy the files.

If you want to create a new folder, click New Folder  and 
type a name for the folder.

4 Click Copy. The File Copy Progress dialog box appears and 
shows ScanDisc’s progress. 

5 Click Done to proceed to the repair process. The Damaged 
Files dialog box appears listing the damaged files that were 
copied.

6 Click Continue to continue the ScanDisc process.

If there were any files that ScanDisc could not recover, the 
Unrecoverable dialog box appears with a list of the files.

The ScanDisc Progress dialog box appears showing that the 
ScanDisc process is complete.
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Troubleshooting DirectCD

Explorer Cannot See Files Copied to the CD
You may not be able to see files on a CD using Windows Explorer for 
several reasons. The table below summarizes the most common 
reasons and possible solutions.

Possible Reasons Possible Solutions

The file was deleted or the 
CD was erased.

If the file was deleted or the CD was 
erased, you cannot retrieve the data.

The writing process was 
interrupted before the file 
directory information was 
completed, but most or all of 
the data files were written to 
the CD. This means that the 
files may be on the disk, but 
Windows Explorer cannot 
see them.

Try using ScanDisc. See Checking CDs for 
Problems on page 52.

The CD’s rated speed did 
not match the write speed of 
your drive.

Check the rated speed of the CD and the 
write speed of the CD-Recorder. The CD 
should be rated the same speed or higher 
than the CD-Recorder speed. For 
example, if your CD-Recorder is a 2x 
speed, you should use CDs rated at 2x, 4x, 
or higher.
If the CD has a lower speed rating, either 
use a different CD or change the write 
speed of the CD-Recorder. See Changing 
DirectCD’s Options on page 37.
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Fixing an Unreadable CD
If no DirectCD window appears after about 15 seconds when you 
insert a CD you made with DirectCD, the CD may be damaged or 
have an unreadable format. This situation can occur, for example, if 
the CD-Recorder temporarily stalls while you are writing a large file 
to the CD. 

DirectCD has a utility, ScanDisc, that may be able to recover your 
files from the CD and make it usable. See Checking CDs for Problems 
on page 52.
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With CD Copier, you can make backup copies of almost any type of 
CD. The most common use for making a copy of a CD is to make a 
working copy of a CD and to archive the original in a safe place.
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Note: CD Copier is designed to assist you in reproducing 
material in which you own the copyright or have obtained 
permission to copy from the copyright owner. Unless you 
own the copyright or have permission to copy from the 
copyright owner, you may be violating copyright law and be 
subject to payment of damages and other remedies. If you 
are uncertain about your rights, contact your legal advisor. 

What Kinds of CDs Can I Copy?
The following table lists the types of CDs that you can copy, as well 
as some notes for making those copies.

Type of CD Notes

Data ■ Some commercial CDs are designed to prevent 
copying, and will not allow you to make a copy. 

■ Only single session data CDs can be copied in Disc-
at-Once mode.

Music ■ The CD-ROM or CD-Recorder drive used as the 
source drive must support digital audio extraction. 
(Easy CD Creator tests your drive to determine its 
capabilities when the source CD is inserted.)

■ You can copy music CDs in Disc-at-Once mode if 
your CD-Recorder supports Disc-at-Once mode.

DirectCD ■ Some CD-ROM drives may not be able to read a CD 
made with DirectCD. If your CD-ROM drive is 
MultiRead capable, there should be no problems.

Mixed-Mode ■ Some mixed-mode CDs copy perfectly while others 
do not. If your mixed-mode CD cannot be copied, the 
CD may be formatted to prevent copying.

Enhanced CD ■ Copy enhanced CDs in Disc-at-Once mode; 
otherwise, some audio may be lost if there is less than 
a two-second gap between tracks on the source CD.

Photo CD ■ Requires a source CD-ROM drive capable of reading 
CD-ROM XA. Most current drives support this.

Video CD ■ Requires a source CD-ROM drive capable of reading 
CD-ROM XA. Most current drives support this.
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Note: Due to technical limitations of CD-ROM and 
CD-Recorder drives, not every type of CD can be copied 
perfectly. Problems can arise from both the source CD-ROM 
drive and the source CD. Select the Test option in the CD 
Copier Advanced Tab settings to determine if your system 
can successfully copy a CD. 

Using the CD-ROM as the Source Drive
If you have a CD-ROM drive, you can copy directly from a source 
CD to a blank CD in your CD-Recorder. The CD-ROM drive is used 
as the source drive and the CD-Recorder as the destination drive.

Note: When you insert a CD into your source drive and 
select the drive in the Source and Destination tab, Easy CD 
Creator automatically tests both the drive and the CD. The 
tests determine whether the selected drive can successfully 
read the selected CD. If it cannot, an error message appears. 

Using the CD-Recorder as the Source and 
Destination Drive
If you have only a CD-Recorder and no CD-ROM drive, you can 
copy a CD using the CD-Recorder as both the source and destination 
drive. Simply select the CD-Recorder as the drive in both the Copy 
From and Record To drop-down list boxes. This requires you have 
enough space on your hard disk to temporarily copy the contents of 
the source CD. See Making a Disc Copy on page 65.

Note: Making a disc copy speeds up the recording process 
and eliminates the need to swap the source and blank CD in 
and out of your CD-Recorder. When you make a disc copy, 
CD Copier copies the CD as a temporary image file on your 
hard disk, then records it to a blank CD. 
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Copying a CD
To copy a CD:

1 Start CD Copier. From the Easy CD Creator Project Selector 
window, click CD Copier.

2 Insert the source CD from which you want to make copies into 
your CD-ROM or CD-Recorder drive.

3 On the Source and Destination tab, select the drive containing 
the source CD in the Copy From drop-down list box.

Note: If you are copying directly from a CD-ROM drive, see 
Using the CD-ROM as the Source Drive on page 63.

4 Select the destination drive that contains the blank CD in the 
Record To drop-down list box. This is your CD-Recorder.

5 Make changes, if any, in Advanced tab settings.

6 Click Copy to begin recording a copy of your CD.

CD Copier begins copying the files and folders listed in your source 
CD to a blank CD. When the CD is finished, a final message box 
appears notifying you that the copying is complete. 

Copying Music and Mixed-Mode CDs
Although most CD-ROM drives can play back music from a music 
CD, not all are capable of reading and copying music tracks in 
digital format.
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Making a Disc Copy
You can speed up the recording process if you are making multiple 
copies of a CD by first making a disc copy. Making a disc copy also 
allows you to copy a CD if you have only a CD-Recorder and no 
CD-ROM drive in your system. The CD-Recorder is used as both the 
source and destination drive.

To make a disc copy:

1 Insert the source CD from which you want to make copies into 
your CD-ROM or CD-Recorder drive.

2 Select the drive containing the source CD in the Copy From 
drop-down list box.

3 Click the Advanced tab.

4 Under Disc Copy, select Copy Source CD to the Hard Drive 
First.

Note: You need enough available space on your hard disk to 
copy the source CD. A 74-minute blank CD typically holds 
up to 650 MB of data; an 80-minute blank CD up to 700 MB 
of data.

5 Select a different location on your hard disk if you do not want 
to record the image file to your Windows Temp directory 
(optional).

6 Click Copy.

CD Copier temporarily records the CD to your hard disk as an 
image file, then records it to the blank CD. CD Copier automatically 
removes the image file after the CD has been copied. 
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Making Multiple Copies
You can make multiple copies of a CD more quickly with CD 
Copier’s Disc Copy feature if:

■ Space is available on your hard disk.

■ Your source CD-ROM drive is slow.

■ Your CD-Recorder serves as both your source and destination 
drive.

See Making a Disc Copy on page 65.

CD Information Properties
To view the CD Information properties:

■ From the File menu, select CD Information. The CD 
Information dialog box appears.

This dialog box displays information about the CD in the 
selected CD-Recorder or CD-ROM drive. It displays the CD 
type, how many sessions, and how many tracks are on the CD.

Click Help on the CD Information dialog box for details about 
the specific property settings. 

CD Drive Properties
To view the CD Drive properties:

■ From the File menu, select CD Drive Properties. The CD Drive 
Properties dialog box appears.

This dialog box displays information about the CD-Recorder 
or CD-ROM drive, including the vendor, product ID, and 
firmware revision. It also displays the various features 
supported by the drive.

Click Help on the CD Drive Properties dialog box for details 
about the specific property settings. 
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Frequently Asked Questions

Is Easy CD Creator 5 Basic compatible with Windows 2000 or 
Windows XP?

Easy CD Creator 5 Basic is compatible with Windows 2000 
Professional, Windows XP Home Edition, and Windows XP 
Professional. In addition it is also compatible with Windows 95/98/
Me/NT4.

Note: Upgrading to Windows 2000 or Windows XP from an 
existing Windows 95, 98, Me, or NT4 system may cause 
compatiblity problems with your installed software because 
vendors often have different versions of their software for 
Windows 95/98/Me/NT4/2000/XP, or because the same 
software is installed differently depending on the operating 
system involved. If you upgrade from Windows 95, 98, Me, 
or NT4 to Windows 2000 or Windows XP, you must reinstall 
Easy CD Creator 5 Basic. 

Why won’t the music CD I made play on my home or car CD player?

To play the CD in your home or car CD player:

■ The CD must be made in the standard CD audio format (the 
Red Book standard). Home or car CD players cannot read 
audio files (for example, WAV, MP3, or WMA) on a Mac or ISO 
9660 formatted CD.

■ If the CD you made has a single session only, the session must 
be finalized.

■ If the CD you made has multiple sessions, only the first session 
can be played on most home or car CD players. The first 
session must be finalized. 

■ If the CD you made was recorded with a CD-RW disc, you 
cannot play it on most home or car CD players.

■ The CD player must be MultiRead capable—check with the 
manufacturer for details. If the CD player is not MultiRead, it 
may have problems reading from a CD-R disc (some brands of 
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How do I make a music CD from multiple CDs?

You can easily make a music CD from multiple CDs. See Making a 
Compilation Music CD on page 11.

Problems Reading Recordable CDs
If you have successfully recorded a CD but have problems reading 
it, here are some suggestions:

■ The CD can be read on the CD-Recorder but not on a standard 
CD-ROM drive.

CD-ROM drives cannot read data from a session that is not 
finalized. You may want to try a different brand of CD-R 
media. If possible, use CD-R media that is recommended by 
the CD-Recorder manufacturer.

■ The CD can be read on your CD-Recorder but when you insert 
the CD in a standard CD-ROM drive, the following occurs:

■ The CD is ejected.

■ You receive error messages.

■ You have random problems accessing some files or 
directories.

You may have a CD-ROM drive that is not well calibrated. Try 
reading the CD in a different CD-ROM drive, or try a different 
brand of CD-R media. If possible, use CD-R media that is 
recommended by the CD-Recorder manufacturer.
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Getting Help

Online Help
Additional details are provided in each application’s Online Help. 
Online Help is available:

■ In Easy CD Creator, from the Help menu, select Contents and 
Index.

■ In DirectCD, click Help  in the upper right corner of the 
window.

■ In CD Copier, from the Help menu, select Help Topics.

Easy CD Creator Online Support
If you can’t find the answers you’re looking for in the Easy CD 
Creator Online Help or the User’s Guide, you can get the most 
current information from our Website at http://www.roxio.com.
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